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Preface 

This document provides step-by-step instructions to install the Oracle Financial Services Financial 

Accounting and Reporting Standards (IFRS and CECL) Pack 8.0.6.1.0 Maintenance Level 

Release. 

This chapter discusses the following topics: 

 Audience 

 How this Guide is organized 

 Recommended Environment 

 Related Documents 

 Conventions Used 

Audience  

The Oracle Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 

pack Installation and Configuration Guide is intended for administrators and implementation 

consultants who are responsible for installing and maintaining the application pack components.  

The document assumes you have experience in installing enterprise components. Basic knowledge 

about the OFSAA IFRS pack components, OFSAA Architecture, UNIX commands, Database 

concepts, and Web Server / Web Application Server is recommended. 

Prerequisites for the Audience 

The document assumes that you have experience in installing Enterprise components and basic 

knowledge about the following is recommended.  

The following are the expected preparations from the administrator before starting the actual 

installation: 

 Oracle Financial Services Advanced Analytical Applications Infrastructure pack components 

 OFSAA Architecture 

 UNIX Commands 

 Database Concepts 

 Web Server/ Web Application Server 

How this Guide is organized? 

The Oracle Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 

pack Installation and Configuration Guide includes the following topic: 
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 Oracle Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 

Recommended Environment 

For best viewing of Infrastructure pages, set the screen resolution to a minimum resolution of 1024 

x 768 pixels. 

Related Documents 

This section identifies additional documents related to OFS IFRS Infrastructure. You can access 

Oracle documentation online from Documentation Library OHC Documentation Library. 

 Oracle Financial Services Loan Loss Forecasting and Provisioning User Guide 

 Oracle Financial Services Hedge Management User Guide 

Conventions and Acronyms 

Conventions Description 

Actions are indicated in Bold. 

Command or query is indicated in Courier New font. 

AIX Advanced Interactive eXecutive 

Atomic Schema Database schema where the application data model is uploaded. 

Config Schema Database schema which contains setup related configurations and metadata. 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

FTP File Transfer Protocol 

GUI Graphical User Interface 

HTTPS Hypertext Transfer Protocol Secure 

IR Interim Release 

J2C J2EE Connector 

J2EE Java 2 Enterprise Edition 

JDBC Java Database Connectivity 

http://docs.oracle.com/cd/E60529_01/homepage.htm
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Conventions Description 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

JVM Java Virtual Machine 

ML Maintenance Level  

OFSAAI Oracle Financial Services Analytical Applications Infrastructure 

OFS AAAI Oracle Financial Services Advanced Analytical Applications Infrastructure 

Application Pack 

OHC Oracle Help Center 

RHEL Red Hat Enterprise Linux 
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1 OFS Financial Accounting and Reporting Standards (IFRS and 

CECL) Pack Release 8.0.6.1.0 

This Maintenance Level release (ML) of OFS Analytical Applications (OFSAA) Financial Accounting 

and Reporting Standards (IFRS and CECL) is cumulative and includes all enhancements and bug 

fixes done since the OFS Analytical Applications (OFSAA) Financial Accounting and Reporting 

Standards (IFRS and CECL) Application Pack v8.0.6.0.0 release. For more information, refer to 

the Oracle Financial Services IFRS Release 8.0.6.0.0 Installation Guide. 

1.1 Pre Installation Requirements 

 The minimum patch set level should be 8.0.6.0.0. 

 OFS IFRS is compatible with WebLogic 12.2.x and does not support WebLogic 12.1.3. If the 

WebLogic version is 12.1.3, upgrade to WebLogic 12.2.x 

 To configure the Oracle Database 19c Server and Client on a new installation, see MOS Doc 

ID: 2691006.1. 

 For details about configuring the Oracle Database Release 19c Server and Client for existing 

installations of OFSAA running Oracle Database Release 12c Server and Client, see the MOS 

Doc ID: 2699715.1. 

 Enable the unlimited cryptographic policy. By default, JCE Policy JAR files are available for the 

Java versions mentioned in the following link and for later versions: 

https://bugs.java.com/view_bug.do?bug_id=JDK-8170157 

For Java versions, where unlimited cryptographic policy is not enabled by default, perform the 

following steps: 

1. Download the JCE Policy related JARs: local_policy.jar and US_export_policy.jar. 

 For Oracle Java, download it from the following location: 

http://www.oracle.com/technetwork/java/javase/downloads/jce-7-download-

432124.html 

 For IBM Java, download it from the following location: 

https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=jcesdk 

2. Copy (or replace) the downloaded JCE Policy related JARs, local_policy.jar, and 

US_export_policy.jar, into the /jre/lib/security folder of Java installation directory used for 

OFSAAI and the web application servers. 

http://docs.oracle.com/cd/E60529_01/homepage.htm
https://bugs.java.com/view_bug.do?bug_id=JDK-8170157
http://www.oracle.com/technetwork/java/javase/downloads/jce-7-download-432124.html
http://www.oracle.com/technetwork/java/javase/downloads/jce-7-download-432124.html
https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=jcesdk
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1.2 How to apply this Patch? 

1.2.1 Installing OFS IFRS 

Refer to the following instructions to download, extract, install, and configure this patch: 

1. Login to https://support.oracle.com/ and search for 28448321 under the Patches & 

Updates tab. 

2. Download the OFSAA 8.0.6.0.0 IFRS ML RELEASE #1 archive file and copy it to your 

OFSAA server in Binary mode. 

NOTE:  There are different archive files for different operating systems such as AIX, 

Solaris, and RHEL/OEL. 

3. Stop all the OFSAAI services. For more information, see the Start/Stop Infrastructure 

Services section in Oracle Financial Services Financial Accounting and Reporting 

Standards (IFRS and CECL) Pack Installation Guide Release 8.0.6.0.0. 

4. Login to the OFSAA server as a non-root user and navigate to the $FIC_HOME folder. 

5. Assign WRITE permission to the files/ folders such as common scripts, 

EXEWebService, ficapp, ficweb, and ficdb in the $FIC_HOME folder by executing the 

command: 

chmod -R 775 * 

6. If you have to Unzip utility, skip to the next step or download the Unzip utility (OS-

specific) and copy it in Binary mode to the directory that is included in your PATH 

variable, typically $HOME path or directory in which you have copied the 8.0.6.1.0 ML. 

 Uncompress the unzip installer file using the command: 

uncompress unzip_<os>.Z 

NOTE:  If you notice an error message “uncompress: not found [No such file or 

directory]” when the package is not installed, contact your UNIX 

administrator. 

7. Give EXECUTE permission to the utility using the command: 

chmod 751 unzip_<os> 

8. Extract the contents of the 8.0.6.1.0 ML archive file using either of the following 

commands: 

unzip_<os> -a <name of the file to be unzipped> 

OR 

unzip –a <name of the file to be unzipped> 

https://support.oracle.com/
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
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NOTE:  The above “-a” option is mandatory to unzip the archive file. 

9. Update the params.conf file present in the OFS_IFRS_PACK/OFS_IFRS/conf folder. 

The update instructions are present in this file itself. 

If you do not have permission to create a new folder for backup, then provide an 

alternate location as value for BACKUP_LOCATION tag in params.conf file, present in 

OFS_IFRS_PACK folder. 

In case of customized datamodel upload, then update the params.conf file present in 

the OFS_IFRS_PACK/OFS_IFRS/conf/ folder accordingly. 

10. Give EXECUTE permission to the ML patch installer script. Navigate to the folder 

OFS_AAI and execute the command: 

chmod 755 OFSAAIUpdate.sh 

11. Execute the following command:  

./OFSAAIUpdate.sh 

12. Verify if the ML is applied successfully by checking the log files generated in 

OFS_IFRS_PACK/OFS_IFRS/logs and OFS_IFRS_PACK/logs folders. You can ignore 

ORA-00001 and ORA-02292 in the log file. In case of any other errors, contact Oracle 

Support. 

13. Post successful installation of the ML, perform the following steps: 

 Clear the application cache. Navigate to the following path depending on the 

configured web application server and delete the files. 

o Tomcat: <Tomcat installation folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

o Weblogic: <Weblogic installation location>/domains/<Domain 

name>/servers/<Server name>/tmp/_WL_user/<Application name> 

o Websphere: <Websphere installation directory>/AppServer/profiles/<Profile 

name>/temp/<Node name>/server1/<Application name>/<.war file name> 

14. Delete the existing EAR/WAR file available in the folder $FIC_HOME/ficweb. 

15. Generate the application EAR/WAR file and redeploy the application onto your 

configured web application server. For more information on generating and deploying 

the EAR/ WAR file, refer to the Post Installation Configuration section in Oracle 

Financial Services Financial Accounting and Reporting Standards (IFRS and CECL) 

Pack Installation Guide Release 8.0.6.0.0. 

https://support.oracle.com/
https://support.oracle.com/
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
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16. Restart all the OFSAAI services. For more information, refer to the Start/Stop 

Infrastructure Services section in Oracle Financial Services Financial Accounting and 

Reporting Standards (IFRS and CECL) Pack Installation Guide Release 8.0.6.0.0. 

17. (Mandatory for OFS LLFP) Download and install the patch 28950933. You can 

download this patch from the Patches & Updates tab of https://support.oracle.com/. For 

more information, see the Readme file available with this patch. 

1.3 Post Installation Configurations 

 You must download and install the mandatory patch 33663417. Ensure that whenever any 

installation or upgrade or an incremental patch is applied, the mandatory patch 33663417 for 

Log4J must be reapplied. For more information, see the MOS Doc ID 2827801.1. 

 Download and install the mandatory patch 30273976, from My Oracle Support. See the 

Readme available with the patch for instructions on installing the patch. 

 Ensure that you have installed the OFS AAI 8.0.6.7.0 ML before you download and install the 

mandatory patches from My Oracle Support. See the Readme available with the patch for 

instructions on installing the patch. 

o Mandatory patch for OFS LLFP: 31714443 

o Mandatory patch for OFS HM: 31964298 

 

NOTE:  In an environment consisting of multiple OFSAA applications, if the October 

2020 Critical Patch Update is applied for any one application, it is mandatory 

to apply the respective October 2020 Critical Patch Updates for all other 

applications on that OFSAA instance, regardless of the application’s version. 

See the My Oracle Support Doc ID 2724021.1 for details. 

 Download and install the compatibility patch 28097119 OFS (ALM 8.0.6.0.1), if your 

environment has both OFS IFRS and OFS ALM co-exist. You can download this patch from 

the Patches & Updates tab of https://support.oracle.com/. For more information, see the 

Readme file available with this patch. 

 If you want to use customized instruments in OFS HM, follow the configurations elaborated in 

Configurations for Customized Instruments – Technical Guide available in MOS Document 

2017368.1. 

 Ensure that you set the initialization parameters accordingly to enable parallelism. 

1.3.1 Configurations for Sandbox Model Creation 

This configuration procedure is specific to OFS LLFP and is required only if you have a licensed 

OFSAAI Enterprise Modelling Framework. 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
https://support.oracle.com/
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=66090864026185&parent=AWIZ_SUBMIT&id=2827801.1&_afrWindowMode=0&_adf.ctrl-state=lds69i6tf_196
https://support.oracle.com/
https://support.oracle.com/
https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=300900198673376&parent=AWIZ_SUBMIT&id=2724021.1&_afrWindowMode=0&_adf.ctrl-state=1dqpmk5qv4_109
https://support.oracle.com/
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=235049199676224&id=2017368.1
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Once you license OFS AAAI, the following configurations must be made to use the Survival 

Modelling feature in OFS LLFP application. These steps are required to verify and execute the 

Survival model that is packaged with the LLFP application.  

NOTE:  Ensure that Oracle R Enterprise Server version 1.5.1 is installed on the database server 

and AAAI Runner Package is installed on the DB server before you perform these 

configurations. Also, you must access the application with the required privileges. 

1. Create a new schema with the following grants: 

grant create SESSION to <<schema_user>>; 

grant create PROCEDURE to <<schema_user>>; 

grant create SEQUENCE to <<schema_user>>; 

grant create TABLE to <<schema_user>>; 

grant create TRIGGER to <<schema_user>>; 

grant create VIEW to <<schema_user>>; 

grant create MATERIALIZED VIEW to <<schema_user>>; 

grant create SYNONYM to <<schema_user>>; 

2. Grant RQADMIN role to the Config schema user: 

GRANT RQADMIN TO <<config_schema>>; 

GRANT RQADMIN TO <<atomic_schema>>; 

GRANT RQADMIN TO <<pdmodel_schema>>; 

3. Execute the following queries, if Data Redaction is enabled: 

alter user <<pdmodel_schema>> default role RQADMIN; 

grant OFS_SEC_DATA to <<schema_user>>; 

grant OFS_NOSEC_DATA to <<schema_user>>; 

4. Create a new database from System Configuration menu. 

5. Add the TNS entry for the newly created database. 

6. Create a new Information Domain for Sandbox and create a new Segment. 

7. Map the Sandbox Information Domain to the group LLFP Admin Group. 

8. Map the EMF groups to the LLFP admin user. 

9. Login to Config schema and execute the file ofs_llfp_aai_model_menu.sql. This file is 

present in the folder $FIC_HOME/scripts_OFS_IFRS_8.0.6.1.0/config/insert. 

1.3.1.1 Configurations for Verifying and Executing PD Model 

Perform the following configurations to verify and execute the PD Model. 
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1. Log in as LLFP Admin user and create a Sandbox from the OFSAAI menu. Use the 

dataset IFRS ECL Consolidated for creating this Sandbox. 

2. Disable the FK constraint (FK_MF_MODEL_DS_QUERY_1) defined in the table 

MF_MODEL_DS_QUERY, in Config schema. 

3. Replace the place holders ##LLFPSBXINFODOM## and ##LLFPSANDBOX_ID## 

with Sandbox Information Domain name and Sandbox ID respectively, in the following 

tables of Config schema: 

 MF_MODEL_MASTER 

 MF_MODEL_SCRIPT_MASTER 

 MF_MODEL_DS_QUERY 

4. Enable the FK constraint FK_MF_MODEL_DS_QUERY_1, in Config schema. 

5. Update all the occurrences of the term “Timestamp” to “Date Time” in the following 

files, present in the folder ftpshare/<<SANDBOX_INFODOM>>/erwin/scripts/sandbox: 

 FSI_TRANSITION_MATRIX_MST.xml 

 FSI_PERIOD_TM_MAP_MST.xml 

 FSI_IFRS_ECON_SCENARIO_MST.xml 

If your ORE version is 1.5.1, open the Model IFRS9_PD_Projection (Description: IFRS9 PD 

Projection model) in Sandbox Schema and update the following script: 

Existing Script (ORE version 1.5.0): 

if(MISDate!=-1) 

{ 

OFSDATASET <- 

OFSDATASET[OFSDATASET$MIS_DATE==as.Date(as.character(MISDate),"%Y%m%d")

,1:15] 

} 

New Script (ORE version 1.5.1): 

if(MISDate!=-1) 

{ 

OFSDATASET <- 

OFSDATASET[as.ore.date(OFSDATASET$MIS_DATE)==as.Date(as.character(MISDa

te),"%Y%m%d"),1:15] 

} 
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1.3.1.2 Configurations for Verifying and Executing Survival Model 

Perform the following configurations to verify and execute the PD Model. 

1. Replace the place holders ##SURVIVALSBX## and ##SANDBOXID## with Sandbox 

Information Domain name and Sandbox ID respectively, in the following tables of 

Config schema: 

 MF_MODEL_MASTER 

 MF_MODEL_SCRIPT_MASTER 

 MF_MODEL_DS_QUERY 

2. Execute VW_SURVIVAL_MODEL.sql and vw_survival_model_derived_entity.sql, 

after the Sandbox is created. These files are present in the folder 

$FIC_HOME/scripts_OFS_IFRS_8.0.6.1.0/atomic/create. 

Once these configurations are set, you can follow the OFSAAAI Installation Guide to view, execute, 

and deploy the model from Sandbox. For more information, see Oracle Financial Services 

Advanced Analytical Applications Infrastructure Application Pack Installation and Configuration 

Guide available in Oracle Help Centre Documentation Library.  

1.3.2 Creating Global Variables for OBIEE 

To create the global variables for OBIEE, in this release of IFRS application, perform the following 

procedure: 

1. Host the RPD and Catalog for LLFP/HM solution as part of this release. 

2. Login into OBIEE/analytics using the application URL. 

3. Click the Analysis link. 

 

4. Click and select the subject area as IFRS 9. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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5. The subject area details are displayed. 

Expand a folder and double click on any column from the subject area. 

Click the Edit formula menu item. 

 

6. Click the Variables tab and select the Global option from the menu. 

 

7. Create a global variable with the following details: 

 Variable Name: denomination 

Value: case when '@{denomination}{in thousand}' = 'in thousand' then 1000 

else 1000000 end 
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This variable is used to divide all amount values by thousand or million, depending 

on the selected criteria. 

NOTE:  For OFS HM, this variable alone is sufficient. 

 Variable Name: RSkey 

Value: case when "Run"."Run Execution Id" = '@{RunId}{1476270723292}' 

then "Run"."Run Skey" end 

 Variable Name: stage 

Value: "Previous IFRS9 Stages"."IFRS Stage Code" 

8. Refresh the materialized view by executing the following queries: 

 EXECUTE 

DBMS_MVIEW.REFRESH(LIST=>'FCT_IFRS_STG_DETERMINATION_MV'); 

This refreshing of MV should be done when there is a change to the Stage 

Determination table. 

 EXECUTE 

DBMS_MVIEW.REFRESH(LIST=>'FCT_COLLECTIVE_ASSESSMENT_MV’); 

1.3.3 Configurations to Deploy the LLFP/HM BI Application 

The following are the steps to configure the LLFP/HM BI Analytics: 

Note: If your OBIEE version is 11g, the RPD and Catalog files for LLFP/HM are IFRS.rpd and 

IFRS.catalog. For OBIEE version 12c, the RPD and Catalog files for LLFP/HM are 

IFRS_12.2.1.x.0.rpd and IFRS_12.2.1.x.0.catalog. 

Before you begin this process, ensure that Oracle Business Intelligence (Version 11.1.1.9.0 or 

12.2.1.3.0) installation is completed and is available. 

1. Set the <Oracle BI Instance Home> directory. 

For example: /u01/OBIEE11G/instances/instance1 

2. Start WebLogic AdminServer. 

a. Set the <BI Domain Home> directory. 

i. For Example: 

/u01/OBIEE11G/user_projects/domains/bifoundation_domain 

b. Navigate to <BI Domain Home >/bin and execute the following command: 

nohup ./startWebLogic.sh & 
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NOTE:  Bringing up this service may take a few minutes depending on your 

environment. Check the logs using the command: 

tail –f nohup.out 

3. Start Node Manager.  

a. Set the < WebLogic Server Home > directory>.  

For example: /u01/OBIEE11G/wlserver_<version> 

b. Navigate to <WebLogic Server Home>/server/bin and execute the following 

command: 

nohup ./startNodeManager.sh & 

4. Start WebLogic Managed Server (bi_server1).  

a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup).  

b. Under the Environment tab, click the Servers link. 

 

The bi_server1 displays the shutdown state at this point. 

 

c. Click the Control tab.  

d. Select the bi_server1 line by clicking on the left tick box.  
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e. Click the Start button at the top of the list and confirm starting this service. 

 

f. The state will update to the “RUNNING” mode after a few minutes. 

5. Start OBIEE services and log in. 

a. Starting services From EM screen: 

i. Log in to the EM administration screen using the URL: http://localhost:7001/em 

(Replace the hostname and port number based on your setup). Use the login you 

created in the OBIEE installation to log in.  

ii. Expand the 'Business Intelligence' node on the left and choose Coreapplication.  

 

iii. Click the Overview Tab. 

 

iv. Click Restart (or Start) under the Manage System section.  
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v. Click Yes on the dialog box to confirm the action. Wait for a message that 

confirms the successful restart. 

b. If the start process using EM is not successful and returning an error about 

OPMNCTL not up, follow the starting process with OPMNCTL.  

i. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.  

ii. Execute the command ./opmnctl status. This displays the status of all the 

OBIEE core services  

iii. Execute the command ./opmnctl startall or ./opmnctl stopall depending on 

your requirement. 

6. Deploy RPD and web catalog file(s).  

If your OBIEE version in 11g, perform this procedure: 

a. Navigate to folder $FIC_HOME/LLFP_DASHBOARDS/ which contains 

IFRS.rpd/IFRS_12.2.1.x.0.rpd file and $FIC_HOME/LLFP_DASHBOARDS/ which 

contains IFRS.catalog/IFRS_12.2.1.x.0.catalog file.  

i. Login to OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em).  

ii. Click on coreapplication from the Business Intelligence tab on the left-hand 

side.  

iii. Under coreapplication, select the Deployment tab and click the Lock and Edit 

Configuration button located below the title coreapplication. The following 

screen is displayed: 

 

iv. RPD Deployment: Select the Browse button available under the Upload BI 

Server Repository section and select IFRS.rpd/IFRS_12.2.1.x.0.rpd file from the 

local folder. Enter the Repository password ‘Admin123’.  
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If your OBIEE version in 12c, perform this procedure: 

 Copy the RPD file to the /bitools/bin folder present in the Weblogic 

domain path. 

 Execute the datamodel.sh file present in /bitools/bin folder to deploy 

RPD. 

./datamodel.sh uploadrpd -I <IFRS.rpd/IFRS_12.2.1.x.0.rpd> -SI 

ssi -U weblogicuser -P weblogicpassword 

 Restart the Weblogic server. 

v. Web catalog Deployment:  

 Create a new web catalog folder for the LLFPBI application through the 

Enterprise Manager of OBIEE. 

 Set the Catalog Location available under ‘BI Presentation Catalog’ as 

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComp

onent/$COM PONENT_NAME/catalog/LLFPBI.  

 Click Apply and then click Activate changes. The following pop up is 

displayed after successful activation.  

 

 Click the Close button and switch to the Capacity management tab.  

 Restart the presentation services. Under the System Components 

Availability, select Presentation Services and click on Restart Selected 

option.  
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vi. Once the Presentation Service is restarted, it displays the pop up notifying the 

successful restart. Click Close.  

vii. Verify that the new folder structure is created in the system. It can be found under 

path: <Oracle BI Instance Home> 

\bifoundation\OracleBIPresentationServicesComponent\coreapplication_obips1

\catalog\LLFPBI 

viii. This LLFPBI folder will be having a root folder which in turn contains three folders 

named shared, system, and users. 

 

b. Open the Catalog Manager  

i. Navigate to File menu and open the catalog online (File->Open catalog) by giving 

the necessary credentials based on your setup (Type - (online), URL - 

(http://<ipaddress>:<port>/analytics/saw.dll).  

ii. Once the catalog is opened, it displays a folder structure on the left-hand side. 

Select the shared folder in the LHS tree structure.  

iii. Go to the ‘File’ menu and select ‘Unarchive’. It asks for the path for a file.  

iv. Browse the path of the archived catalog file saved in your local folder using the 

Browse button in the pop-up. Click OK.  

v. The catalog is unarchived in a specified location. A pop up for successful 

operation is displayed. Restart the presentation services once again.  

c. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) and login with 

credentials based on your setup. Verify the availability of the catalog. 

If your OBIEE version in 12c, perform this procedure: 

a. Deploy the Catalog file in OBIEE Catalog Manager. 

b. Navigate to the 12c Analytics URL, http://serverip:serverport/analytics/saw.dll. 

c. Login to the URL with Weblogic credentials. 

d. Unarchive the catalog file. 

7. Configure tnsnames.ora.  
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a. Open tnsnames.ora file under the folder - <Oracle Home>/network/admin.  

b. Make sure that an entry is made in the tnsnames.ora to connect to the atomic 

schema of the OFSAA application.  

c. Save the tnsnames.ora file.  

8. Configure the ODBC data source to connect to Oracle BI Server.  

a. Navigate to Control Panel>Administrative Tools>Data Sources (ODBC).  

b. Select the System DSN tab and click the Add button.  

c. Select a driver-specific to (Oracle BI Server 11g) and click the Finish button.  

d. Enter Name and Server details (specify the Host Name or IP Address of the BI 

Server) and click Next.  

e. Enter Oracle BI Server login id and password (Enter User Name and Password 

created at the time of OBIEE installation). Click Next.  

f. Click Finish.  

9. Modify the connection pool and set the properties.  

a. Open the OBI Administration tool.  

b. Select Start > Programs > Oracle Business Intelligence > BI Administration.  

c. Enter the Repository password as ‘Admin123’. (You do not need to provide this 

password if you are using OBIEE version 12c). 

d. In the Physical layer, double-click the Connect Pool. The properties of Connection 

Pool LLFP is displayed. 

e. In the General tab, edit / check the following entries:  

i. Call Interface: (OCI 11g/12c).  

ii. Data source name: <tnsnames.ora entry created in the step 8.b connecting to 

OFSAA atomic schema>.  

iii. User name: <enter atomic db user name>.  

iv. Password: <enter atomic db user password>.  

v. Confirm password and Click OK to close the window.  

vi. Similarly, configure the connection pools for ‘LLFPBI’. 

NOTE:  Repeat similar steps from (g) above for connection pool 'Connection 

Pool MR' under Database 'Market Risk'.  

vii. Click Save to save the RPD file.  
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viii. Click No for the Global Consistency Message.  

ix. Close the RPD file (File / Exit).  

10. Login into LLFP/HM BI Application using the URL: http://localhost:<port 

number>/analytics (Replace the port number based on your setup). 

1.3.4 Image Deployment in OBIEE for OFS HM Application 

For Image deployment in OBIEE, perform the following steps depending on the OBIEE version: 

 For OBIEE 11.1.9.5 version deploy the images at the following path and restart the OBIEE 

services: 

$(DOMAIN_HOME)/servers/bi_server1/tmp/_WL_user/analytics_11.1.1/7dez

jl/war/res/s_blafp/meters/light/stop 

 For OBIEE 12.2.1.3 version deploy the images at the following path and restart the OBIEE 

services: 

${MW_HOME} 

/user_projects/domains/bi/servers/bi_server1/tmp/_WL_user/analytics/

za01ic/war/res/s_blafp/meters/light/stop 

1.3.5 Updating OBIEE URL 

To access the respective Business Intelligence Analytics Application, you need to update the 

OBIEE URL in the table 'AAI_MENU_B', once the OBIEE environment is up and running. 

The following statement needs to be executed in the config schema: 

UPDATE AAI_MENU_B 

SET V_MENU_URL = '<obieeURL>' 

WHERE V_MENU_ID IN ('<List of enabled BI Analytical Links for a particular 

Media Pack >') 

/ 

COMMIT; 

/ 

For OFS LLFP: 

UPDATE AAI_MENU_B SET V_MENU_URL = 'http://ifrsip:port/analytics' WHERE 

V_MENU_ID IN ('OFS_LLFP_ANALYTICS’) 

/ 

COMMIT; 
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/ 

For OFS HM: 

UPDATE AAI_MENU_B SET V_MENU_URL 

='http://ofss2221196.in.oracle.com:7001/analytics' WHERE V_MENU_ID = 

'OFS_HM_ANALYTICS'; 

/ 

COMMIT; 

/ 
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